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A Whole New Look 

Since it was first introduced in 1983, Microsoft Word has established a 
reputation as one of the most versatile and powerful word processors 
available. Now, with the release of version 5.5, Word achieves outstanding 
new ease of use. 

Consider Word's new pull-down menus. As you browse through them, 
more of Word's capabilities are spread out to choose from than ever before. 
Every command can be seen from the menu level , including features like 
macros that previou-sly could be accessed only through function keys. 

Take a look at the new dialog boxes, too. They present more information, 
so they're easier to understand. Some dialog boxes even contain "buttons" 
you can choose when you want to go directly to another dialog box, in case 
you chose the wrong command, or if you want to do an additional task. 

The new formatting ribbon is another significant innovation. It strengthens 
the capability already found 
in Word 's ruler for fast, interactive 
formatting. So routine character and style 
formatting is simpler and more intuitive. 

But the new menus, dialog boxes, and 
ribbon are just a part of the most impor­
tant new feature of Word 5.5, its inter­
face-all the different ways you can give 
commands and communicate with the 
program. The new interface not only 
makes Word easier to learn and use, it ' s 
also part of an emerging standard, shared 
by Microsoft Windows and hundreds of 
programs that run in the Windows environment. Once you learn one program 
that uses the interface, learning other programs with the same interface 
becomes much easier. 

With version 5.5, Word for DOS also draws closer to other members of 
the Microsoft Word family. Word for DOS now looks very similar to and 
works much the same as Word for the Macintosh and Word for Windows, so 
you can use your Word skills in all three environments. 

The number-one request from Word users was to make Word easier. 
Word 5.5 is our response to that challenge. We think you'll like it. ❖ 
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Introducing the 
Formatting Ribbon 

The ruler in Word version 5.0 pro­
vided an easy way to set tabs and move 
indents . Now, with the Word 5.5 for­
matting ribbon , you can apply the most 
commonly used character formats and 
styles with the same ease. The ribbon 
works well with a mouse, and it 's also 
simple to access from the keyboard. For 
example, CTRL+ F activates the Font 
box, and you can then press AL T+DOWN 

ARROW to see the li st of available fonts. 
In addition to making it easy to ap­

ply formats, the ribbon provides con­
tinuous feedback on the formatting of 
text as you type or the formatting of 
any text you have selected (if you select 
text with mixed formats, the relevant 
format box is empty). In previous ver­
sions of Word, you had to choose the 
Format Character command to check 
the font or font size of your text; with 

the ribbon , that information is always 
available on the screen. 

For mouse users, the ribbon is par­
ticularly speedy. Along with the conve­
nience of point-and-click formatting, 
the ribbon offers a couple of mouse 
"hot spots": you can double-click on 
"Font" or "Pts" to bring up the Format 
Character dialog box, and you can 
double-click on "Style" to bring up the 
Format Apply Style dialog box (use thi s 
dialog box to check style definitions or 
to apply character and section styles). 

In addition to showing the style key 
code, as the style bar does, the ribbon' s 
style box shows the style I.D. of the 
current paragraph style. And when you 
pull down the li st o: styles, you can 
also see style remarks, which help you 
identify the styles you want to apply . ❖ 

Where to find information on the 
ribbon and ruler: Using Microsoft 
Word, Chapter 6, "Text Formatting: 
Characters and Paragraphs" and 
Chapter 28, "Style Sheets." 
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Moving from 
Word 5.0 to Word 5.5 

Word 5.5's pull-down menus, dialog 
boxes, and scroll bars all contribute to 
give Word a friendlier personality . But 
if you've used earlier versions of Word , 
there are a few changes in the interface 
to watch out for. Word comes equipped 
with some options and special Help to 
ease the transition to version 5.5. 

Help for Word 5.0 users The "Word 
5.0 to 5.5" command on the Help menu 
takes you to a menu of on line Help 
topics for users of Word version 5.0 
and earlier versions. If, for example , 
you have trouble finding a Word 5.0 
command, you can use this help to dis­
play a command map that shows the 
Word 5.5 equivalents of all Word 5.0 
commands. You can also di splay topics 
that show how Word 5.0 function keys, 
speed formatting keys, and mouse 
actions map to their equivalents in 
Word 5.5. In addition, there's a termi­
nology topic , reprinted in thi s 
newsletter on page 11, li sting Word 
terms that have changed. 

Function keys For consistency with 
other programs that share Word 's inter­
face, including Microsoft Windows, 
many of Word' s function key ass ign­
ments have changed. One benefit of 
these changes is that you ' II be able to 
use your knowledge of Word 's function 
keys in other programs. To make it 
easier to learn and remember function 
keys, many of them are now li sted on 
Word 's menus, next to their command 
equivalents. 

But if the traditional Word function 
key assignments are engraved in your 
memory (or embedded in your fingers), 
you can opt to keep using the Word 5.0 
function keys.To do so, turn on the 
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Use Word 5.0 Function Keys check box 
in the Utilities Customize dialog box. 
Word 's function keys will work just as 
they did in Word 5.0, except that the FI 

key invokes Help. 

INSERT AND DELETE keys The INSERT and 
DELETE keys behave differently in 
Word 5.5 for the same reason the 
function keys do-to be consistent with 
other programs that share the Word 5.5 
interface. But if this consistency isn't 
important to you, and you 're used to 
how the keys worked before, you can 
opt to have them work as in earlier 
versions of Word. To do so, tum off the 
Use INS as Overtype check box in the 
Utilities Customize dialog box. 

If, on the other hand, you ' re willing 
to take the plunge and try the Word 5.5 
keys, check the Quick Reference Card 
and online Help to see how they work 
before using them (you can also refer to 
the chart included on page 5 of this 
newsletter). There is one important 
difference to note in particular: the 
DELETE key's editing actions have been 
reversed. That is, in Word 5.0, you 
pressed DELETE to delete text to the 
scrap and SHIFT+DELETE to delete text 
permanently. In Word 5.5, you press 
DELETE to delete text permanently and 
SHIFT+DELETE to delete (or cut in 
Word's new terminology) text to the 
scrap. The danger here, of course, is 
that you may end up deleting text per­
manently when you only meant to cut it 
temporarily. Until you're comfortable 
with the DELETE key's new behavior, 
use it carefully! If you do make a 
mistake, you can use the Undo 
command to remedy it. ❖ 

Where to find information on making 
the transition to Word 5.5: Online 
Help, "Word 5.0 to 5.5" command on 
the Help menu; Getting Started, 
Chapter 1, "Welcome to Word" 

The Top 5.5 Things to Know 
About the New Word 

1 Pu ll-down menus and dialog boxes Out with the old menus, in with the 
new. The new "pull-down" menus and dialog boxes should do more to en­
hance your productivity than any other feature of Word 5.5. They make 
Word's power more accessible, so that you'll be more likely to make use of it. 
All the familiar Word commands are available on the menus, although a few 
have taken on new, more intuitive names. The Transfer Load command has 
become File Open, for example. For more on Word 5.5 terms, see "A Few 
Name Changes" in this newsletter. 

2 The formatting ribbon Located just below the menu bar, the new formatting 
ribbon provides fast, interactive style and character formatting (if you don't 
see the ribbon on your screen, use the View Ribbon command to make it 
visible). For more on the ribbon, see "Introducing the Formatting Ribbon" in 
this newsletter. 

3 Better Help Online Help has been significantly upgraded. There's almost 
three times as much of it, to begin with, and the Help feature includes new 
capabilities to make Help more accessible. Now you can have your document 
and on line Help on the screen simultaneously-so you can perform a task in 
your document and read instructions in Help at the same time. Many Help 
topics are linked to each other so that you can press a "button" for instant 
access to cross-references. For more on Help, see "More Help, Better Help" in 
this newsletter. 

4 A smooth transition Word 5.5 comes with some tools and options to make 
the upgrade process easier. There's a special command on the Help menu 
-Word 5.0 to 5.5-just for users of Word 5.0. It takes you directly to Help 
showing terminology changes, changes in editing keystrokes, how the old 
Word menus re late to the new ones, and how old function key assignments 
relate to new ones. And although the INSERT and DELETE keys and many func­
tion keys work differently in version 5.5, you can opt to have them work just 
as in Word 5.0 (in the Utilities Customize dialog box, tum on Use Word 5.0 
Function Keys and tum off Use INS for Overtype Key). For more on making 
the transition to version 5.5, see "Moving From Word 5.0 to Word 5.5" in this 
newsletter. 

5 Overlapping windows Working with multiple documents, always one of 
Word's strengths, is simpler and more flexible in Word 5.5. The new docu­
ment windows can be sized and moved around, and they can overlap, so that 
you can quickly bring a document into view when you need it and hide it when 
you don't. 

5.5 Required Setup The files on your Word 5.5 disks are compressed, and 
you need to use the Word 5.5 Setup program to decompress them. As with 
earlier versions of Word, Setup remains the fastest and easiest way to get 
Word running on your computer. ❖ 

3 
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A Sample 
from the Menus 

Word ' s new pull-down menus and 
dialog boxes have simplified access to 
many of Word 's most advanced fea­
tures. Let's take a quick look at some of 
these features to get a sense of Word 
5.5 as a whole. 

Glossary Word glossaries provide a 
convenient way to store text you use 
frequently . In Word 5.5, they're much 
easier to use, because you can do all the 
important glossary tasks--creating and 
inserting glossary entries and handling 
glossary files- from one place, the Edit 
Glossary dialog box. 

In earlier versions of Word, you 
used a variety of different commands to 
handle glossary entries and files . Now 
it's all right there in one dialog box. 
The glossary feature is a great example 
of how Word's redesigned menus and 
dialog boxes allow functions to be 
organized more intuitively than was 
possible before. 

Importing graphics, spreadsheets, or 
documents Whether you're importing 
a graphic, spreadsheet information, or a 
document, the procedure is very similar 
in Word. So it makes sense to put the 
relevant commands on the same menu. 
Two new commands, Insert File and 
Insert Picture, replace four Word 5.0 
commands: Transfer Merge, Library 
Link Spreadsheet, Library Link 
Graphics, and Library Link Document. 

You use Insert File to insert infor­
mation from a spreadsheet or text from 
another document. You can also choose 
to create a link to the spreadsheet or the 
document that can be updated if the 
information in the original spreadsheet 
or document changes. A nice feature of 
the Insert Picture dialog box is that you 
can press a "button" to go directly into 
Print Preview so you can see what 
you've imported. 
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Styles Styles provide a powerful way 
to apply the same formatting many 
times. If you never mastered styles, 
you'll find it much easier to do so now. 
If you did master them, you ' II 
appreciate how much simpler they are 
to use. 

Styles have benefitted from two sig­
nificant innovations in Word 5.5: the 
formatting ribbon and style sheet 
windows. 

Through the Styles box on the 
ribbon , you can, with a keystroke or a 
click of the mouse, see the li st of sty les 
on the attached style sheet. And you can 
just as easily record, apply, and change 
the formatting of a style. 

Style sheet windows are the Word 
5.5 equivalent of Gallery mode in 
earlier versions of Word. When you 
choose Define Styles from the Format 
menu, the style sheet attached to your 
document opens in a sty le sheet 
window. When a style sheet window is 
active, a special set of commands for 
style sheets appears on the menus (just 
as Gallery mode had its own set of com­
mands). But you can do several things 
with style sheet windows that couldn't 
be done in Gallery mode. For example, 
you can have a document window and a 
style sheet window visible on the screen 
at the same time. This allows you to 
change a style's formatting and see the 
effect of thatchange in your 
do1;ument-as you change the 
formatting of a style, text in your 
document will change also. 

Macros You can use Word's macro 
feature to record and store actions that 
can then be played back at high speed. 
In Word 5.5, macros have become 
much more accessible because they 
now have their own menu, with 
commands for recording, running, and 
editing macros. The new Macro Run 
dialog box li sts all the macros stored in 
the current glossary file (the list of 
macros is no longer mixed in with 
regular glossary entries). ❖ 

Tips on Key Changes 
Word 's menus have changed, and the actions assigned to many keys have 
changed also. This overview of the changes should help to make sense of the 
changes. When you need a reference, choose the Keyboard command from the 
Help menu or refer to the Quick Reference Card. You can also check Help for 
special Help on the differences between Word 5.0 and Word 5.5 keys (choose 
the "Word 5.0 to 5.5" command on the Help menu). 

t Speed formatting keys In earlier versions of Word, speed formatting keys 
began with the ALT key (ALT+B for bold, for example). In Word 5.5, they 
begin with the CTRL key (CTRL+B for bold, for example). In addition, you no 
longer need to include an "x" in speed keys when a style sheet is attached. 

t Style key codes Style key codes began with the ALT key in earlier versions 
of Word. In Word 5.5, they begin with CTRL+SHIFf. 

t Function keys As part of the new interface, many function key actions have 
changed in Word 5.5. You can choose the "Word 5.0 to 5.5" command on the 
Help menu for a comprehensive chart on the differences between version 5.0 
and version 5.5 function keys. If you want to continue using the function keys 
with their Word 5.0 assignments, tum on the "Use Word 5.0 Function Keys" 
check box in the Utilities Customize dialog box (the FI key is permanently 
assigned to Help, however) . 

t Scrolling keys Scrolling keys are the same in Word 5.5, with the following 
exceptions: 

To move cursor to Word 5.0 Word 5.5 

Start of document . . Ctrl+PgUp . . Ctrl+Home 
End of document . . Ctrl+PgDn . . Ctrl+End 

Top of window . . Ctrl+Home . Ctrl+PgUp 

Bottom of window Ctrl+End Ctrl+PgDn 

t Copying , Inserting , and Deleting Keys The actions of these keys have 
changed significantly, as shown in the table below: 

To Word 5.0 Word 5.5 

Copy to scrap. . Alt+F3. Ctrl+Ins 

Delete to scrap .Del. . Shift+Del 

Delete permanently . Shift+Del .Del 

Insert from scrap . Ins. . Shift+lns 

Insert, replace selected text. Shift+lns . Del, Shift+Ins 

If you want the INSERT and DELETE keys to work as in Word 5.0, you can turn 
off the Use INS for Overtype Key check box in Utilities Customize. ❖ 
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More Mouse Power 

Microsoft Word has long been fa­
mous for having the best mouse support 
of any word processor. But with version 
5.5, the mouse really comes into its 
own. That 's because virtually every­
thing in the new Word interface was 
designed with the mouse in mind. For 
browsing through menus, selecting 
items in a dialog box, switching 
windows, and many other actions, the 
mouse is convenient and fast. 

Word 5.5 also has new " icons" just 
for the mouse. Icons are special images 
on the screen that perform specific 
actions when you click on them. The 
icons in Word 5.5 are the equivalent of 
the different mouse cursor shapes in 
earlier versions of Word, but they ' re 
better because they're always on the 
screen (unless you choose to hide 
them), and they're available in both 
graphics and text modes . 

For example, at the top of the verti­
cal scroll bar, you can click on the 
ruler/ribbon icon to turn the ruler and 
ribbon on and off. That icon is visible 
as long as you have the scroll bar or 
window borders turned on, and it serves 
as a useful visual reminder. Or consider 
the scroll bar itself. With the scroll bar, 
it 's much easier to scroll your docu­
ment, and you have better control as 
well: using the scroll arrows, you can 
scroll line by line, which wasn't possi­
ble in Word 5.0. 

Although the right mouse button is 
still useful-and necessary for some 
actions, such as turning on the ribbon 
-you can rely on the left button to do 
most of what you need. Most of the 
time, you don't need to think about 
which mouse button to use-just point 
and click. 

As with earlier versions of Word, 
you can still use the mouse in combi­
nation with the keyboard for many 

useful functions. One of the quickest 
ways to copy a format, for example, is 
to select the text you want to format, 
then hold down the CTRL+SH!Ff keys 
and click next to the text whose format 
you want to copy. Some of the 
keystroke and mouse combinations 
have changed in Word 5.5 (including 
copy format). Check the Quick 
Reference Card or online Help for the 
new keystrokes and a complete list of 
mouse functions. 

Finally, don ' t overlook the new 
mouse "hot spots," which are really 
shortcuts to quickly call up a dialog 
box. They can be quite useful. For 
example, you can double-click any­
where on the status bar (except on the 
Help button) to bring up the Edit Go To 
dialog box. ❖ 

Where to find information about 
using the mouse: Online Help, 
"Mouse" in the main index; Quick 
Reference Card. 

New Ways 
to Customize 

Word version 5.5 provides even 
more opportunities to adapt Word to 
your needs. 

Changing screen colors You can 
change the colors of more screen 
elements in Word 5.5-15 more than 
you could in Word 5.0, to be exact. To 
help manage all these color settings, 
Word 5.5 comes with predefined color 
sets, including sets designed to work 
well with monochrome and LCD 
displays. You can also choose to have 
black text on a white background, a 
much-requested option Uust choose 
white as the Window Background 
color). 
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Showing or hiding screen elements 
Screen elements consist of all the things 
on the screen that aren't part of your 
document. Scroll bars, the ruler, and the 
menu, for example, are useful screen 
elements. But sometimes you don't 
need them, and it can be nice to have 
the extra room to see more of your 
document. You can hide every screen 
element, and the ones you 'II want to 
hide or display most often-the ruler, 
ribbon , and status bar-are on the View 
menu for easy access. If you want a 
totally "clean screen" so you can 

You can hide every screen 

element individually-or all of 

them/or a "clean screen." 

concentrate exclusively on what you 're 
writing, you can hide all the screen 
elements (in Word 5.0, you could hide 
everything except the status bar). 

Where to set options In Word 5.5, 
options have been sorted into two 
dialog boxes. The View Preferences 
dialog box handles all the options that 
affect what you see on the screen. The 
Utilities Customize dialog box contains 
the options that change Word's opera­
tion in some way-whether or not 
background pagination is turned on, for 
example. Both dialog boxes have 
buttons that link them to each other, so 
if you choose the wrong command, you 
can select a button and go directly to 
the dialog box you need. Three other 
options, to show or hide the ruler, 
ribbon , and status bar, are on the View 
menu for easy access. ❖ 

Where to find information on these 
features: Using Microsoft Word, 
Chapter 3, "The Word Screen." 
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More Help, 
Better Help 

The Word 5.5 online Help system 
contains nearly three times as much 
information as was in version 5.0 and, 
more important, offers some powerful 
new capabilities to make Help more 
accessible. 

For the first time, you can display 
Help and work on your document at the 
same time. For example, you could 
display and read the procedure for 
creating a glossary entry at the same 
time you create one in your document. 
Help appears in its own window now, 
just like a document. So you can 
display it, size it, or hide it with the 
same ease you can a window. 

Many Help topics include built-in 
links to other topics with related infor­
mation. If you 're looking at a topic and 
decide you want to learn more about a 
subject, you can quickly jump to related 
topics. You can also choose to print any 
Help topic just by choosing File Print. 

Help can be accessed either through 
the Help menu, which offers several 
choices to guide you directly to what 
you want, or by pressing Fl . The Fl key 
is most useful if you're in a dialog box 
or have received an error message and 
want to get instant Help. Pressing Fl in 
a dialog box calls up reference infor­
mation for the specific dialog box 
you're in. When you find out what you 
need, you can press ENTER to return to 
the dialog box and continue your work. 
The same is true for error messages. If 
you don't know what an error message 
means, simply press Fl while the 
message is still on the screen to get an 
explanation and suggestions on what to 
do. ❖ 

Where to find information on 
Help: Online Help, "Using Help" on 
the Help menu; Using Microsoft Word , 
Chapter 4, "Getting Help." 

fU@ Edit View Insert ForJ11at Utilities Macro Uindow Help 
•============= DocuJ11ent3 ==============t 

♦ ~--------- Help ---------~ 
PRINT DIALOG BOX (Screen 1 of 5) 

Printer, Port, and PRD 
The currently selected printer, port, and .PRD 

S file display at the top of the dialog box. 

Print 
Select the type of inforJ11ation you want to 

P print. 

Copies 
P Type the nuJ11ber of copies you want to print. 

Uord reJ11eJ11bers the preuious setting until you 
( change it. One copy is the default setting. 

I 
<F'agti Up> <Page t n> 01( : 

-~i!~i!~ii~i!lmi~ 
Pg1 Co3 {} <F1=Help> 
Prints the active docuJ11ent; changes printing options 

When u dialug box is on the screen, you can press Fl to get instant reference information on 

options in the dialog box. This screen shows Help for the File Print dialog box. When you' re 

done with Help , press ENTER to return to the dialog box. 

File Edit View Insert ForJ11at Utilities Macro Uindow Help 
•=========== GALLEYoB.DOC ============t 

re to find infol'lliltion ahou using 
the .ause: Online Help, "Mouse" in 
the nain index and Quick Reference 
Card.'D 
'II 
'II 
'II 

(Index) <Back) 

DEFINING A GLOSSARY ENTRY 

Oueruiew: (Edit Glossary coJ11J11and) 

To define a glossary entry: 
1. Select the text you want to store as a 

glossary entry. 

Pl Sl C1 {} <Fl=Help> 
Edit docuJ11ent or press Alt to choose connands 

<Exit) 

Microsoft Uord 

You can work on your document and display a Help procedure at the same time. In this 

screen, the procedure for defining a glossary entry is l'isible; the first step, selecting the text to 

be stored as a glossary entry, has been taken. 
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Macros Made Easier 

In Word 5.5, macros come out into 
the open and gain a new ease of use. 
You no longer have to be a Word 
wizard in order to record, run, or edit a 
macro. You can do it right from the 
new Macro menu, where each of these 
basic functions has its own command. 
Since it takes less effort to take advan­
tage of the macro capability, you ' II find 
yourself using it and benefitting from it 
more often . 

Now that macros have their own 
menu and commands, you don't access 
them through the Glossary command 
anymore. Macros are still stored in 
glossary files , but they're listed in the 
Macro Run and Macro Edit dialog 
boxes. When you want to see the list of 
avai lable macros, you see macros on ly, 
not macros and glossary entries mixed 
together. 

The Macro Edit dialog box is the 
new central command post for macros . 
All of the tools you need to work with 

macros and the glossary files that con­
tain them are there. If a macro you want 
to run isn't in the current glossary , you 
can open the one you need. You can 
edit a macro by selecting it and choos­
ing the Edit button; after editing, you 
can redefine it by selecting the macro 
text and choosing the Define button . 

Macro changes and improvements 
Here's a summary of the improvements 
and changes you ' II find in the macro 
capabi lity and language. 

t You can start a macro from the 
system prompt line by typing 
word Im Macroname. 

t The macro language includes some 
new reserved variables to accommodate 
the new interface. 

t The SET and ASK commands 
produce dialog boxes , which are friend­
lier and more visible than message line 
queries. 

t When you interrupt a macro, Word 
gives you the option of turning on step 
mode (useful for testing). You can also 
turn on step mode when you start a 
macro in the Macro Run dialog box. 

Fi le Edit U i ew Insert For111at Utilities tt@ijij/ IJ i ndow Help 
•============ GALLEYGB .DOC ============t 

.------------- Edit 11acro -------------. 
11acro l'!a111e: 11acro Eeys: 
[bulleted list ·················· · I 
Macros: 

[{ctrl W>a ........ . ... J 

authority_entry <ctrl W>6 
authority_table <ctrl W>7 

3_delete (ctrl W>D 
3_undelete (ctrl IJ)U 
archiue_author (ctrl U)4 i\Uj\i~1ViikJtyiJJt¥.! ? > 
archiue_docu111ents 
archiue_keyword (ctrl U)S 

clean_screen (ctrl IJ)C 
clear_scrap (ctrl IJ)L 

1. •.••······ ·· ••.•.•.•····-·········· ............ ··•······· ........ rnm:::rn:: •· •·•·•·•••·•: · ....... ·: ...... ....... :.: ... :.:.::: ... . ;;; ;.; .• ;,;.; ;.;; .. 
bulleted_list: 11acro (Glossary) File: 11ACRO.GLY 

«SET -echo="off "»'ll(enter )store(r3}(backspace}'ll(enter · ... 

<nefine> < De lete > (Open Glossary ... ) 
( Edit ) (Clear All> <Save Glossary ... ) (11e,'ge .. . ) (Close) 

Revises a 111acro 

The Edit Macro dialog box is the new central command post for macros. 
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t You can now assign macros to 
SHIFr+CTRL key combinations as well 
as to CTRL and function key combina­
tions. Be careful to avoid conflicts with 
style key codes, which use CTRL+ SHIFf, 

and formatting speed keys, which use 
CTRL. 

t You can override macro key 
assignments using CTRL+ A (in Word 
5.0, this key was CTRL+ X). 

Converting your Word 5.0 macros 
Since a Word macro is primarily a 
record of keystrokes, and the 
keystrokes used to access commands 
have changed, you must convert your 
Word 5.0 macros to use them in Word 
5.5. Word comes with a useful tool for 
this purpose, the macro conversion pro­
gram, MACROCNY.EXE. This utility 
converts many macros correctly, but is 
unable to convert some Word 5.0 
commands. For a fuller explanation of 
the capabilities and limitations of the 
macro converter, see Using Microsoft 
Word, Chapter 22, "Macros." 

Additional Supplied Macros The sup­
plied macros included with Word 5.0 
are still available, and a few new ones 
have been added as well. Among the 
new macros included: 

t The copy _file macro to copy a 
document and any graphics linked to it 
to a directory you specify. 

t The filename macro, to insert your 
document name at the cursor position. 

t The print_letter macro, to print 
the first page of a document with differ­
ent margins-useful for stationary 
whose first page requires special 
margins. ❖ 

Where to find information on 
macros: Using Microsoft Word, 
Chapter 22, "Macros" 
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More Changes 
and Improvements 

In addition to, and in some cases as 
part of, the new interface, Word 5.5 
includes a number of small but useful 
refinements. 

Character formatting speed keys 

same key combinations regardless of 
whether a style sheet is attached to the 
document (in earlier versions of Word, 
you had to include an x in speed key 
combinations when a style sheet was 
attached to your document). Finally, if 
you just want to format a single 
character, you just select the character 
and format it; you no longer have to use 
the speed keys twice, as in previous 
versions of Word. 

you unless you want it to (unlike the 
traditional Word highlight, which was 
equivalent to a one-character selection). 

Selecting text works a little differ­
ently with the new cursor, depending on 
whether you are selecting to the left of 
the cursor or to the right. If you select 
to the left, the selection begins with the 
character just behind the cursor. If you 
select to the right, the selection includes 
the character the cursor is on. For 
example, if the cursor is on the r in 
Paris, and you select left, the selection 
begins with the a; if you select right, 

Speed keys have been simplified. In 
Word 5.5, character formatting speed 
keys work as toggles, which means that 
you use the same key combination to 
tum formatting off as to tum it on. For 
example, you type CTRL+B to turn bold 
on and off. Also, you always use the 

The new cursor The new cursor pro­
vides better control over selecting. You 
can always tell whether text is selected, 
since the cursor, a blinking underscore, 
is easily distinguished from a selection. 
And the cursor does not select text for 

the selection begins with the r. 
Most people prefer a blinking cursor 

for the visibility that blinking provides, 
but you can turn off the blinking by 

How We Produced This Newsletter Using Word 
A newsletter provides a great opportunity to give Word 

a real workout. Virtually all of Word's more powerful fea­
tures can come into play, from styles and glossaries to 
graphics linking and positioning. 

The first step toward producing this newsletter was to 

create two simple style sheets, DRAFT.STY and 
LAYOUT.STY. Both style sheets used the same style I.D.s 
and key codes; only the formatting of the styles was differ­
ent. We used LAYOUT.STY to format the articles into the 
basic column size and type style of the newsletter, so that 
we could work up a rough layout. The second style sheet, 
DRAFT.STY, formatted the articles in double-spaced para­
graphs for the editor and reviewers to mark up. 

Once the styles had been applied to the articles, chang­
ing their formatting for an editing draft or layout was as 
simple as attaching the appropriate style sheet. 

Each newsletter article had its own file to keep the files 
small and manageable. But when the articles were ready to 
be edited and laid out, it was more convenient to have them 
in a single file. So we used Insert File to link the articles 
into a master document. Later, after making changes to the 
individual article files, we selected Update Link (in the 
Insert File dialog box) to update the master document. 

When we were ready to begin production, we added 
more styles to LAYOUT.STY. In fact, we created a style 
for each different character and paragraph format used in 
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the newsletter (the complete style sheet has 20 styles). 
Applying the styles didn't take long, though, since the bulk 
of the text had been formatted earlier, as the articles were 
being written. 

Our next step was to bring the different graphics we 
needed into the document, including the headers and mast­
head (created with Aldus Freehand) and screen images 
captured using the Word screen capture program, 
CAPTURE.COM. We sized the screen images using Insert 
Picture and then positioned them using Format Position. To 
check the positioning, we used View Layout to switch to 
layout view and Print Preview to get the big picture. 

With the graphics in position and the styles applied we 
were ready to typeset. We printed to a file using Word's 
PostScript printer driver, and then fed that file to a 
Linotype Linotronic L300 typesetter. After typesetting, we 
were ready to go to the printer. No paste-up or additional 
layout was required (the printer added screens for color like 
the shading in this box). 

This newsletter doesn't appear regularly, as most 
newsletters do. If you 're going to be putting out a newslet­
ter frequently with Microsoft Word, keep an eye out for 
ways you can use Word to make the process more efficient. 
After you've produced a couple of issues, you should be 
able to spot a few things that can be automated with macros 
or streamlined with styles. There are many possibilities! ❖ 
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typing word Ii at the DOS prompt (the 
non-blinking cursor is available in 
graphics mode only). 

Windows and panes You can split a 
document window into two "panes" for 
more than one view of your document. 
You can use panes to compare different 
parts of a document or to see your 
document in outline view in one pane, 
for example, while you work on the text 
of your document in the other. 

There may be times when you want 
larger views of a document than a pane 
can provide. In that case, you can open 
a new window on the document 
(choose the New Window command 
from the Window menu). When you're 
through with the second window, you 
can close it and your document will 
remain open in the first window. 

Search within a selection To give you 
the ability to limit a search to part of a 
document, Search now searches just 
within a selection. This is more 
consistent with the way Replace works. 
For example, you could use Search to 
check the first five pages of a report to 
see if you've mentioned "net profit." 

Word Count The Word Count feature 
now has a place on the Utilities menu, 
and you can choose it at any time for a 
very fast count. Word automatically 
inserts the count into the scrap, Word 's 
temporary storage area, so that you can 
easily paste it into your document. Best 
of all, you can select part of your 
document, and Word Count will count 
just within the selection. For the many 
publishing situations where the number 
of words is critical, this is a wonderful 
enhancement. 

Faster spelling If you're an imperfect 
typist but a good speller, you can make 
spell checking go faster by turning off 
Always Suggest in Spelling Options, so 
that Word doesn 't search for suggested 
corrections. Then, when Word finds a 
misspelling, you don't have to wait for 

it to suggest a correction; you can 
simply type the correction. Spell 
checking is quicker this way, 
particularly if most of the errors you 
correct are typos. 

Conversion improvements The Word 
RTF conversion program can now read 
styles in RTF files created by Word for 
the Macintosh or Word for Windows. 
The improved conversion capability 
makes it easier to work with Word on 
more than one platform. Thanks to the 
improved styles support, you can now 
move a file to Word for the Macintosh 
and back to Word 5.5 without losing 
style formatting. ❖ 

Where to find information on these 
features: Using Microsoft Word, 
Chapter 2, "Scrolling, Selecting Text, 
and Choosing Commands"; Chapter 6, 
"Text Formatting: Characters and 
Paragraphs"; Chapter 8, "Searching and 
Replacing"; Chapter 26, "Spelling and 
Hyphenation"; and Appendix C, 
"Changing File Formats." 

Printer Support 
Expanded 

Microsoft Word was the first word 
processor to exploit the capabilities of 
laser printers and continues to support 
new developments in printing 
technology. Word 5.5 includes support 
for color PostScript, the new LaserJet 
III family of printers, and more than 50 
other new printers. 

Here are summaries of the printer­
related changes you'll find in Word 5.5. 

t You can add support for new 
LaserJet fonts by using the Word 
MergePRD utility and the Tagged Font 

Matrix (TFM) files included with new 
LaserJet fonts. (Support for virtually all 
the existing LaserJet downloadable and 
cartridge fonts is included with Word 
5.5, but new fonts appear on the market 
all the time.) 

t Word now supports true gray-scale 
background shading on printers with 
that capability, including PostScript 
printers, LaserJet printers and compat­
ibles, and the Canon LBP III and IV. 

t If you run Word under OS/2, you 
no longer have to issue a separate 
command to connect to a network 
printer-you can type the name of your 
network printer destination in the 
Connect To box of the File Printer 
Setup dialog box. 

t Using the File Printer Setup dialog 
box, you can tell Word not to prompt 
you to download fonts whenever you 
print a document formatted with 
downloadable fonts. This is helpful if 
you often use downloadable fonts but 
seldom need to download them. 

t To make room for the new printers 
Word supports, some printer drivers 
have been moved from the printer disks 
included with Word to the 
Supplemental Printer Disks that can be 
ordered separately. But for most of the 
printer drivers included on the 
Supplemental Printer Disks there is no 
need to update . Your Word 5.0 printer 
drivers will still work for Word 5.5. If 
you're happy with your Word 5.0 
printer driver, you don ' t need to order 
the Supplemental Printer Disks. ❖ 

Where to find information on 
printing and printers: Using 
Microsoft Word, Chapter I 0, 
"Printing"; Printer Information for 
Microsoft Word. 
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A Few Name Changes At Your Service 

The names for some Word com­
mands and functions have changed. 
Here 's a chart adopted from an online 
Help topic for users upgrading from 
Word 5.0 (choose the "Word 5.0 to 5.5" 
command on the Help menu, then 
choose Terminology to see this Help 
topic). 

Word 5.0 Word 5.5 

Autosort _______ ____ Sort 
Clear Close 
Division __________ Section 
Gallery ___ __ Style sheet window 
Highlight _ ________ Cursor 
Jump __________ Go To 
Documg.nt retrieval_ --Fil~anaggrnent 
Running head ____ Header or footer 
Summary sheet_ Summary information 
Transfer Load_ File Open or File New 
Transfer Save _______ File Save 
Style Usage ______ Style type 
Style Variant ______ Style I.D. 
Zoom window Maximize window 

Microsoft Product Support 
(206) 462-WORD 
(Microsoft Word only) 
6:00 A.M.-6:00 P.M. Pacific time 

Call this number for: 

• assistance with technical questions 

Microsoft End-User Sales and 
Service 
(800) 426-9400 
6:30 A.M.-5:30 P.M. Pacific time 

Call this number for: 

• information about updating Word 
• Authori-zw-1'-raining Centers 
• product literature 
• information about the handling or 

status of your order 
• help with replacing or repairing your 

product 
• registration questions 
• address changes 

~ CREDITS 

CompuServe and GEnie 

On CompuServe use the Microsoft 
Applications Forum; on GEnie use the 
Microsoft Roundtable for: 

• posting messages requesting 
assistance with technical questions 

• sharing information with other users 
downloading public domain files 

Use the Microsoft Knowledge Base for: 

• researching common questions 
• looki:1g up official Microsoft 

Application Notes 

Use the Microsoft Software Library for: 

• downloading official Microsoft 
printer drivers 

• downloading Microsoft macros, 
templates, utilities, etc . 
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Getting to Know 
Word's New Desktop 
By Peter Rinearson 

This article is adapted from Peter 
Rinearson' s Running Word 5.5 
(Microsoft Press), the revised edition of 
his Word Processing Power with 
Microsoft Word, which since 1985 has 
been the best-selling book on Word. 

When it comes to your computer 
screen, the difference between Word 
5.0 and Word 5.5 is the difference 
between two dimensions and three . 

Imagine that you are leaning over a 
desktop, pondering the items on it. You 
see tools: a ruler, various pens, scissors, 
and a pot of paste. Perhaps there is a 
thesaurus, dictionary, or helpful instruc­
tion book to one side. Handy reminders 
are posted in an eye-catching place. A 
top drawer holds paper clips and other 
useful aids. Near at hand is a file 
drawer storing documents . 

On top of the desk , dead center and 
commanding attention, is a document. 
You see only one page of it, but you 
could thumb through to other pages. 
Perhaps there are other documents , 
under the uppermost one or resting to 
one side. 

Your Word 5.5 screen is a tangible 
expression of this imaginary, three­
dimensional desktop. On it are tools 
such as the image of a ruler and a menu 
of commands that let you perform 
tasks. 

Commanding the center of the 
screen, displayed in its own window, is 
a document. Perhaps there are addi­
tional documents, under the uppermost 
document or to the sides. 

By "uppermost," we mean that the 
document appears to be closest to you, 
unobstructed by other documents or 
windows. Implicit in the term is the 

0990 Part No. 17873 

idea that your screen represents a three­
dimensional desktop, on which things 
can be piled. 

Unlike the two-dimensional Word 
5.0 screen, in which document windows 
abut each other like tiles, in Word 5.5 
you generally work on whichever doc­
ument is on top of the "pile." You 
could say that Word 5.5 "piles, not 
tiles" its windows. 

This is only one of Word 5.5 's many 
departures from earlier norms. Under­
standing a few of these conceptual dif­
ferences makes it easier to translate 
your knowledge of Word 4.0 or 5.0 into 
productive use of version 5.5. 

For example, version 5.5 has an 
insertion-point cursor as well as 
Word's traditional selection cursor. 

After you've used Word 5.5 for 

a few days, the two-dimensional 

Word 5 .0 screen may seem a bit 

flat by comparison. 

While the selection can expand to 
highlight any amount of text, from a 
single character to a whole document, 
the insertion-point cursor doesn ' t 
highlight anything at all. Rather, it uses 
a blinking underline to represent the 
location in your document at which 
newly typed text will be inserted. 

The blinking underline is to the 
immediate right of the actual insertion 
point. Put another way, the insertion 
point is at the left end of the blinking 
underline. You can think of it as a slit 
in the fabric of your document, into 
which text can be inserted. 

Once character formatting is applied 
to the insertion-point cursor, any new 
text you type will be formatted to 
match that formatting. 
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In the past, Word has treated a doc­
ument window and its document as -
distinct entities. You could open a 
document window that did not contain 
a document. You could clear a docu­
ment from a window, leaving it em·pty. 
Or you could replace the contents of a 
window by loading a different docu­
ment from disk. 

In contrast, Word 5.5 blurs the dis­
tinction between a document and the 
window that displays it. Every Word 
5.5 document window contains a docu­
ment, even if the document doesn't yet 
have text. A window and its document 
are inseparable: you cannot clear the 
document from the window or load a 
different document into the window. 

If one document is displayed and 
you open another document from disk, 
the newcomer will appear in its own 
window on top of the first document. 
To replace one document with another, 
you must close the window containing 
the first document, then open the other 
document. 

It 's just as likely, though, that you 
won't replace one document with 
another, as you would with Word 5,0. 
Instead, you'll merely open the new 
document "on top" of the old one. In 
fact, you can pile up to nine documents 
on top of each other, bringing any one 
document to the top of the pile when­
ever you want to. 

After you've used Word 5.5 for a 
few days, the two-dimensional Word 
5.0 screen may leave you feeling a bit 
flat. ❖ 

Peter Rinearson , a Pulitzer Prize 
winning journalist, is creator of 
MasterWord: The Microsoft Word 
Companion Disks, a collection of help 
screens, utilities, and macros for Word 
5.5. For information on the software or 
the book from which this article _is 
adapted, contact Alki Software 
Corporation, 219 First Ave. N., Suite 
410, Seattle, WA 98109. Phone: 1-800-
669-WORD. 


